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Development Tools (Revision)

Coding — Editor => Entry of code into file(s)

Translation — Assembler or Compiler
=> Generate machine code from source code

Execution check — using Debugger to verify
operation of program ( on Simulator )

Program — Programmer

=> Put machine code in the chip

Single Point Solution — IDE e.g. Keil



Keil uVision IDE ...

Project : A collection of files related to a
particular programming task.

Build : The process in which only the files
modified since last build are
assembled/compiled for the chosen
microcontroller device.

Rebuild : The process in which all files are
assembled/compiled irrespective of their
modification state.

Debug : The process of finding errors
happening during program execution and
removing them.



Simulator and Debugger

Simulation of microcontroller behavior while
executing the user program
The Debug mode Ul allows the user to perform
the following
1.Observe microprocessor Registers,
Memory, Ports and Peripherals
2.Place breakpoints to stop simulation as
specific instruction or on condition
3. Monitor code under execution
4. Modify data variables
5. Monitor timing of execution
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Project 1 3 simple_move.asm

Eﬁ Target1

e Assuming you have already built
a program and obtained binary

code file for it, We can use the
simulator available with keil for
debugging programs

E145 Source Group 1
. £] simple_move.asm

mov r0,#3src
mov rl,#dst
mov rZ,#cnt

0 =1 &0 0 b Ld R

9 back: mov a,@r0
10 mov @rl,z
11 inc r0
12 inc rl

djnz r2,back

[l Project | €3 Boaks | {} Functions | 0, Templates 1 m
"

Build Qutput

fFuild target 'Target 1'

linking...

Program Size: data=8.0 xdata=0 code=14
"a"™ - 0 Error(s), 0 Warning(s).
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File Edit View Project Flash | Debug | Peripherals Tools SVCS  Window Help

1y alage | o Fatll Wl o | BRY

1ZH ﬂ‘ _ @‘ | @) | start/stop Debug Session Ctrl+F5 } Iz | L]
S E e | B rarge & Reset U
Project E Run s
Eﬁ Targetl € stop
Ea Sour.ce Group 1 B} Step -
L[] simple_maove.asm
{}* Step Over F10
{} Step Out ctri-f11 [E0#
{} Runto CursorLine Ctrl+F10
v Show Next Statement
mov 2, @8r0
Breakpaoints... Ctri+B Imov @rl,a
@ Insert/Remove Breakpoint g |inc =0
pnc rl
Enable/Disable Breakpaint Ctrl=F9
(5) Disable All Breakpoints r2,back
ﬁ Kill All Breakpoints Ctrl=5hift+F3 ]
3jmp loop
05 Support
Execution Profiling
Memary Map...
Inline Assembly...
E]pmjgct @Egg}-; {} Functions Function Editor (Open Ini Filg)... | 1l
Build Output
Build target 'Target 1'
linking...
Program 5ize: data=8.0 xdata=0 code=14
"a" - 0 Error(s), 0 Warning{s).

4

After a successful build of the
project, following are the resulting
files

1. Binary code is placed in
filename.obj for each source
file in a project.

2. All these obj files are linked
into a single binary named
using the project name
without any extension.

3. If enabled by user
<<filename.hex>> file is
created for the project.

The user can now start the
Debug session to check
execution of the program.

Enter or leave a debug session

Simulation

CAP NUM SCRI
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EVALUATION MODE
i ! . Running with Code Size Limit: 2K

e ¥ |

A popup of Evaluation version is presented which shows the
limitation of the mode.

On clicking “OK” the popup closes and the user is presented
with the Debug Mode user interface (Ul)
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"5 5" User interface in Debug mode

JEH@\
- ANERA I AR *{}|¢>\ o ———

Regisbee T@ Disgseemisty 3]

foe e e =% wa | Disassembly window — shows the
113 inc r0 .
T w I Opcodes for the Program loaded in
b 00 2: inc r
= (D A the debugger. E
r5 000 simple_move.asm v X
S (o ,
- Sys 2 dst equ 40h T
. 3 cntequs .
T G [ Register User program window — shows the
gp 07 . =
L . Assembly or High Level Program ;
i window :
il loaded in the debugger.
e 0 210 mov @rl,z | 4
...... sEC 0.00000000 1; ::an : /
[H paw D0 o inc rl

ﬁ 1 v
EE| Project | == Registers [ " (i

J;l Memory 1 . El@
Memory window

Command

unning with Code Size Limit: 2K
Load "E:\\ACADEMIC\\PBG\\RZ\\pt-51\\programs\ia"

‘Address: Id:ﬂ'[h

D:0x00: 00 00 OO 00 00 00 00 00 00 00 00 OO0 00 00 00 00 0O 00 00 00 OO0 0O 00 00
D:0x1%: 00 00 OO 00 00 OO OO 00 0O 00 OO0 OO OO 00 0O 0O OO 0O 00 OO0 OO0 0O 00 00
D:0x30: 00 00 OO 00 00 OO OO 00 00 00 00 OO0 OO 00 00 0O 0O 00 00 00 OO0 0O 00 00
D:0x4&: 00 00 0O 00 00 OO OO 0O 00 00 00 OO0 0O 00 00 0O OO0 0O 00 00 OO0 0O 00 00
D:0x60: 00 00 OO 00 00 OO OO 00 00 00 00 OO0 OO 00 00 0O OO 0O 00 00 OO0 0O 00 00

Command window

BSM ASSIGN BreakDisable BreakEnable BreakKill BreakList BreakSet BreakAccess

Madify memary at cursor location Simulation 11: 0,00000000 sec CAP NUM SCRL OVR R/W



Peripherals Tools

@ Start/5top Debug Session

% Reset CPU

Run

o Stop
1 step
ﬁ*}' Step Over
Step Cut
1 Runto Cursor Line
¢ Show Mext Statement

Breakpoints...
@& Insert/Remove Breakpoint
Enable/Disable Breakpoint

Disable All Breakpoints

| ﬂ ‘J\ﬂll Breakpuoints

SVCS  Window

Ctrl+F5

F5

F11

F10

Ctrl+F11
Ctrl+F10
Ctrl+B

Fa

Ctrl+F9
Ctrl+5hift+F9

User can execute instructions
in multiple modes :

Run (F5) — Continues executing the
program until the next active
breakpoint is reached or till the
program termination.

Step (F11)-- Executes a single-step
into a function; Executes the
current instruction line.

Step Over (F10) — Executes a single-
step over a function.

Run to Cursor Line (Ctrl+F10)
Allows user to place a cursor and
run the program till that line.




Details of Disassembly and Memory window

||Disassembly

10: CLE F1.4
:Q0=0100 CZ94 CLE 0x20. 4
: Mo

Jurey) RO, #0x1F

Disassembly window

Address

Instruction mnemonic in assembly language

C:O0x0106 SETE ETO(0xA3.1)
15z d

C:0x0103 oy THCOD (0x59) , #0x01

Opcode 0001 : Sets Timer 0 to MODEL

1a: MOV THO,#00H ; Loads THO register with FCH

C:0x010E 75ECO0 MW THO (0=8C) , #Ox00
17: MOV TLO,H#00H ; Lioads TLO register with 13H
<]
Memory 1

[l bhit tTimer).

Address: |C:0:100 «—— Enter address here \

‘ Memory window \

Timer 1 i= not used

C:Ox0100f CZ 94 Vg 1F D2 AF D2 A9 75 §9 01
C:O0x0115: 35 g 04 B2 94 V8§ 1F D2 8C 22 00
CiO0x0130: 00 OONJO 00 00 0o 0o 0o o0 od od

L O 00 00 ao aag
-| Data at address Ox0100 |5 oo oo oo oo
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@1 Call Stack + Locals | [ Memory 1




Code and Data memory access

Memory 1 o

D:0x00: 00 00 OO 0O OO 00 OO 0O OO OO OO OO OO OO OO OO OO OO OO OO OO 00 OO 0O
D:0x1&: 00 00 OO 0O OO OO0 OO 0O OO OO OO OO OO OO OO OO OO OO0 OO OO OO 00 OO 0O
D:0x20: 00 00 OO 0O 00 00 OO 0O 00 OO QO 0O 0O OO OO 00 OO 00 OO QOO 0O 0O OO QO
D:0x4&: 00 00 OO QO OO 0O OO 0O 00 OO QO OO OO OO QO OO OO OO OO QO OO OO0 OO QO
D:0xe0: 00 00 OO OO OO 00 OO OO OO OO OO OO OO OO OO OO OO OO OO OO OO OO0 OO 0O
D:0x78: 00 00 OO 0O OO OO0 OO OO FF O7 OO OO OO OO OO 10 OO 00 OO OO 0O 00 OC 0O
D:0x%0: FF 00 OO0 00 F8 FF FE 00 00 00 OO0 00 00 OO0 OO OO0 FF OO OO0 OO 00 00 OO0 OO 'Y
g;b[all Stack + Locals | Memory 1
simulation t1: 0.00000000 sec 11 CB CAP NUM 3CEL OVRE R/W
Memaory 1 a

Address: |c:00h c: refers to code segment of the memory Wl =

:0O=x0000: T8 30 TH9 40 TA 05 E6& FT 08 09 DA FA 80 FE 00 OO0 00 OO0 OO0 OO0 ©0 OO OO OO
:0O=x0018: 00 OO0 OO OO OO OO OO OO OO0 OO OO0 OO OO0 OO0 OO0 OO0 OO0 OO0 OO0 OO0 OO0 OO0 OO0 00
:0x0030: 00 OO0 OO OO OO OO OO OO0 OO0 OO0 OO0 OO0 OO0 OO0 OO0 OO0 OO0 OO0 OO0 OO0 OO0 OO0 OO0 00
:0x0048: 00 OO0 OO0 OO OO OO OO OO OO0 OO OO OO OO0 OO0 OO OO0 OO OO0 OO OO0 OO0 OO OO0 00
:0x0060: OO0 OO0 OO0 OO OO OO OO OO0 OO0 OO0 OO0 OO OO0 OO0 OO0 OO0 OO OO0 OO OO0 OO0 OO OO0 00
:0Ox007T8: 00 OO0 OO0 OO OO OO0 OO OO OO0 OO OO OO OO0 OO0 OO OO OO OO0 OO OO0 OO0 OO OO0 00
t0Ox00390: 00 00 OO0 OO0 OO OO0 OO OO0 OO0 OO0 OO OO0 OO0 OO0 OO OO0 OO OO OO0 OO0 OO 00 OO 00O ~

nooaonaan

n;;h-:all 5tack + Locals Memory 1

Simulation t1: 000000000 sec L1d 14 CAP MUM| SCEL OVR RAW



Decima
Unsigned L4
Signed ¥
Ascil
Float 3
Doubl
@ Memaory 1 i a3
Modify M t 03D
Address: [d:00n e i .
5et Breakpoint at D:SD : —
D:0x00: 00 00 00 OO0 00 00 OO0 00 00 00 00 00 OSOL 00 00
D:0x18: 00 00 00 OO0 00 00 OO 00 00 00 00 00 00
D:0x30: 00 00 00 OO0 OO0 00 OO OO0 OO 00 00 00 00

D:0x48: 00 00 00 00 OO0 OO0 OO 00 OO0 OO0 OO0 OO0 00 ‘DU 00 O0O0y0o0O 00 00 00 OO0 00 OO0 00
D:0x60: 00 0O 00O 00 OO OO0 OO OO0 OO OO0 OO0 OO 00 OO 00 OOy OO OO OO 00 OO0 00 OO0 OO0
— D:0x78: 00 00 00 00 OO OO0 OO OO0 FF O7 OO0 OO 00 OO 00 1g 00 00O OO0 00 OO0 00 OC OO0
D:0x5%0: FF 00 00 00 F&8 FF FE 00 00 00 00 OO0 00 OO0 00 O FF 00 00 00 OO0 00 00 0O

‘ &L Call Stack + Locals | EEl Memory 1

Simulation t1: 0.00000000 sec / CAP NUM SCRL OVR

During execution, user can right click on the required
memory location in the memory window to modify RAM
data. Functionality for selecting the number system in
which the memory contents are to be displayed is also
available .

Note: To initialize memory contents on hardware, user has
to add necessary instructions in the program code.




FRegisters I EI

Reqgister Walue
=l RHegs
ri Do 300
ri (b0
r2 (b5
r3 b0
rd CecTe0d
r5 e D0
re (e B0
i (e[
- S}"S
a b0 1 1
2 Lok The Registers window
i it provides access to all the
g S registers including the flag
= dptr LD .
o g register, DPTRs etc.
[1] e o0
states i
sEC L EEEEL]
=l pEww el
p 0
1 O
o (]
rs i
Filh i
ac i
Yy 0

ﬂ Project == Registers




4 E\ACADEMI
File Edit Project Flash Debug Peripherals Tools SVCS Window Help

[ (5 Y] statusBar B RAR|EEE S Hae|([@ e o &|[@) %
2 Toaolbars ki — [
=B VE(ERDA- -5~
Registers !@J Project Window ;mbly
Heng@ Books Window 5: mov r0,#src
=Regs | 1} Functions Window e e MOV RO, #0x30
_______ 0 . 6: mov rl,#dst
....... il D oooz 7940 MOV R1, $0x40
_______ (2 ﬁ Source Browser Window 7: mov r2,fcnt
------- 3 | 5] Build Output Window i
"""" |3 FindInFiles Window
"""" B simple_move.asm
....... =] _
_______ :g ;_E_D:! Command Window src equ 30h
! ! = - f . . .
5 sy [ Disassembly Window e =i | |f some windows are not being displayed
"""" a | @ Symbol Window CTL e - ”
"""" b (=] Registers Window N then use the “View” menu to get them on
....... P = -
....... |G Call Stack Window £l,#dst h ]
ey r2 window
....... PC Watch WiﬂdﬂWS/ mov rZ,fcnt t e do .
....... —_— : —
B} dptri Memory Windows | Memory 1 o
------- state Serial Windows Memaory 2 |
"""" 2eC Analysis Windows Memaory 3
[:l ..... psw
Trace Memaory 4
f L 0 8 O A 1
E Project System Viewer 4 ! =
- %+ Toolbox Window i
Command | a Memory 1
|\|'_'r| Periodic Window Update i
Load "E:\\ACADEMIC\\DPG\\RAL\DC-51\\programs\\a" {8 |00
D:0x00: 35 45 00 00 00 00 0O 0O
D:0xi18: 00 OO OO OO0 00 0O 0O 0O
D;:0x30: 00 OO OO OO0 00 0O 0O 0O
- D:0x48: 00 0O OO OO0 00 0O 0O 0O
i r D:;:0x60: 00 OO OO OO0 00 0O 0O 0O
.| D:0Ox78&: 00 00 00 00 00 00 00 00
> D;0x80: FF 00 00 00 F8 FF FE 00
A5SM AS5TGHN BreakDisable BreakEnable BreakKill Breaklist BreakS5et Breakliccess | n;;--"_"mall Stack + Locals | (& Memory 1
Clumsss mr s s dlnm Bl e e IR TR HE A

Chimmo ol =dim e
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- states
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+- pew

|ﬂ M-t i MNamimdars |

LU
00
00
00
00
00

00
00
07
07

C:0x00...

00
(D000

0.0000...

00

|« &

simple_move.asm

1 src equ 20h
dst equ 40h
cnt eqgqu 5

mov @rl,a

mov rd,#src
mov rl, #dst
mov rZ,§fcnt
back: mov &, @8r0

inc r0
inc rl

= ——=k

loop: sjmp ]

end

To set a breakpoint,
user can click in the
marked area against
the corresponding
line of code




n E] Disassembly

Fegisters
Reqgister Yalue
= Regs
L b 30
. bcd 0
e (b5
e (bclh0
. bclhD
o (b0
e i bclhD
g 7 ochD
= S}"E
B g bclhD
'y b0
e gy eV
EUUU B Man b7
~PC % C:baDD...
e A bchD
+ dptr b0
oo atates 0
E BB 0.0000...
[ paw DD

11: inc r0
C:0x0008 08 INC RO
12: inc rl
13:
@ :oxo009 09 INC R1
. K
1 . .
2 The breakpoint is
2 shown as a red dot
=5l s against the line.
3
T
; The
g breakpoint is
5 | 2 automatically
Y P displayed at the
L3 equivalent
1 4 dijnz rZ,back . . .
e line in the disassembly
16 1loop: sJimp loo] window too.
17
18 end




Peripherals menu

File Edit View Project Flash Debug [ Peripherals | Tools SVCS Window Help
- = || Various Peripherals

1can be

Interru
LO-Ports
Serial
Timer
TWI

SPI
Keyboard Interrupt
EEFROM Data
Flash Memory
Clock Control

Command

src
dst
chnt

equ 30h
equ 40h
equ 5

mov
mov
mowv

0,#arc
1,#dst
rd, font

-
-

back: mov a,@ro
mov Brl, =z
inc rO
ince rl

djnz r2,back

RE=1" - I 3 | |
A RERGA R R RO (A
Registers a @ Dt
Reqister ] Value |
=l Reqgs
i) (0D
r O30
ré O30
r3 (00 -
rd DO
5 DO
& DO
7 00 :
= Sys 2
— (00 i
b O30
sp <07 5> 5
Sp_max LU E
PC § C:0x0000 :
aee 00 g
+- dptr (<0000
fo gtates 1] 5710
sec 0.00000000 i
+ paw 00 E
== 14
I] Project | =5 Registers 4|

accessed through the
“Peripherals” menu.

— Timer/Caunter O
tdode
Iﬂmer ‘:J
TCOM: {Ox00  TROD: IDHDD
THO: IEI:-:EIEI TL: {O=00
¥ T0Pin [~ TFO
Control

Statuz; IStu:up

[T TR0 [T GATE ¥ IMTOH

Window
corresponding
to Timer O




Logic analyzer

To start the logic analyzer click on the
highlighted icon or go to

View > Analysis Window > Logic Analyzer.

fiew Project Flash Debug Peripherals Tools
= Fe = o

MO0 2 HEB Ed -
o KHDisassemhly
Wa

C5 Window Help

15: MOV TMOD, #00000001B ; Sets Tiwmer 0 to MODE1l (16
B RS 755901 MRS THOD (0x89) . #0x01




Logic Analyzer window

| Logic Analyzer

oad ... | MinTime  Max Time Grid
o 03 | Os | 0.1 ris

1. Click on Setup

Tranzition

|F're'-.f |Ne:-:t|

Code
| Show |

Setup Minddax
| At || Undo |

Trace |lpdate Screen

| Show |

£
D

[ Signallnfo [ Amplitude
[T ShowCycles [T Curzar

| Stop |

Setup Logic Analyzer | x|

| Current Logic Analyzer-Signals:

0375 us

2. The setup window appears.

R 2
—Signal Display—————  Dizgplaw Range

Dizplay Type: Im b & IUU—
Colar: _ Min: IEIEI—

[ Hexadecimal Display

— Dizplay Formula [Signal & kaszk] => Shift

And Maszk: IDHFFFFFFFF S hift Right; ||:|

— Export / lmport

Expart Signal D efinitions. .. | Irmpart Signal Definitionz... |

kgl [ Dese | [ Hep |




Setup Logic Analyzer

Current Logic Analyzer-=signals:

Setup Logic Analyzer

Current Logic Analyzer Signals:

......

4. Type in the pin you want to monitor
then click on Close.

5. After running a simulation, you can pause it and
look at the timing waveforms to debug your code.

oad ... Min Time hax Time Grid Code Trace Setup Mindbdax Update Scr Tranzition Signalineit [ LA pltide
Save .. | 0s 41.02536 = 02s --E | Show | | Show | | Auto || Undo | | Stop | |F'rev||Ne:-ct| I~ Show Cycles [ Cursor
: — e
o
L : : : : : : : : : :
3B.84B83E = 39.04B636 =



Questions ?



Thank you

WEL Labs, IITB
2016

For doubts/errors in this PPT contact :
Suryakant Toraskar e-mail: smtoraskar.iitbombay@gmail.com location : WELS




